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3-D topometric imaging advances high throughput phenotypic data collection
2-D photogrammetry method for measuring perennial ryegrass (Lolium perenne L.) curves
Novel methods measuring perennial ryegrass spike characters to improve seed retention
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Abstract
Advances in technology have increased adoption of high-throughput phenotyping (HTP) methodologies, potentially replacing laborious and time-consuming measurements and data recording.  One promising HTP tool for fine-featured and small-sized characteristics are 3-dimensional (3-D) scanning and imaging systems, but the utility of present 2-D technology has not been fully explored for this purpose.  The objective of this work was to develop 2-D photogrammetric and 3-D topometric imaging methods for HTP of spike characteristics in perennial ryegrass (Lolium perenne L.) with special attention to traits that might be associated with seed retention.  These HTP imaging systems were compared with direct data capture by hand in spikes of 21 diverse global accessions of perennial ryegrass. The Fiji (ImageJ) open source imaging software was used for photogrammetric analysis of spike structure including spike length, spikelet number, internode length and 2-D curvature of the spike. The optical sensor Artec Space Spider 3-D scanner was used to generate dense 3-D point clouds to measure spike length, spikelet number, internode length, spikelet length, spikelet angle, and 3-D curvature of the spike.  Both methods were found to accurately characterize the subject, the 3-D method was slower than 2-D but was more (P ≤ 0.01) precise than 2-D image analysis with a linear measurement deviation of only 0.17%.  Fiji was effectively used for post-processing image analysis and the Space Spider can be used directly in the field to support HTP data collection. This non-destructive field measurement system facilitates HTP in perennial ryegrass spikes and likely in other applications.
Introduction
Methods for field evaluation of morphological traits in the grasses have long relied on laborious and time-consuming measurements and data recording (Chastain et al., 2015).  Moreover, human measurements and ratings of traits can be subjective and inconsistent.  Several plant characteristics in perennial ryegrass are influential in determining crop yield and tolerance to environmental stress and pests.  Since data collection on these characteristics is slow, the quantity of data gathered is generally limited (low-throughput) on these traits.  
Current advances in technology have increased adoption of high-throughput phenotyping (HTP) methodologies (Araus and Cairns, 2014; Chawade et al., 2019).  This technology has the potential to replace much of the slow and labor consuming human-based data collection with a variety of sensing devices and enabling acquisition of information about plants that was not previously possible.  The use of HTP can aid plant breeding programs in making improvement that might have otherwise been slow or otherwise impossible (Crain et al., 2018).
One set of HTP tools employed in breeding and research of perennial ryegrass relies on capturing data with sensing systems such as multispectral sensors and thermal imaging cameras and using vegetation indices to gain new insights about the phenotype (Jayasinghe et al., 2019; Wang et al., 2019; de Alckmin et al., 2021).  A second set of tools focuses on capturing and assessing morphological characteristics of the plant using multiple methodologies.  A variety of remote sensing tools including ultrasonic sensors, laser imaging detection and ranging (LiDAR) and others have been employed in the measurement of morphological traits in the field such as plant height and architecture, characteristics of the canopy, and crop lodging (Colaco et al., 2018; Yuan et al., 2018; Singh et al., 2019).
One of the most promising new tools in HTP for measurement of morphological traits are 3-dimensional (3-D) scanning and imaging systems (Vázquez-Arellano et al., 2016).  These proximal sensor systems permit the user to capture a 3-D representation of morphological traits in the field.  Data that is captured can be stored indefinitely, providing a virtual record of the subject of interest that can be analyzed now or at some future date.  One advantage of these systems is that measurements can be made multiple times on plants in the field at sequential stages of development without destructive removal.  Limited work to date has been done in the development of HTP methodologies for fine-featured and small-sized morphological traits of inflorescences and flowers in the grasses (Li et al., 2020).  
Seed loss through shattering is a major economic problem in perennial ryegrass seed crops and it is thought that the identification of phenotypic characteristics associated with seed shattering is likely to play a key role in reducing seed losses (Elgersma, 1988).  We investigated the use of Artec Space Spider, a portable, hand-held optical 3-D scanning device for capturing measurements of perennial ryegrass spike characteristics that might be associated with seed retention.  This device uses blue LED as the light source and has resolution to 0.1 mm.  To our knowledge, this device has never been used before in HTP.  Topometry involves imaging techniques to record 3-D positions of an array of points (x,y,z) and as a topographic map provides information about geographical terrain, the topometric image may provide valuable information about the surface characteristics of the inflorescence.  Data on morphological traits also can be captured by use of 2-D photography and measurement of the trait in the captured image by use of a technique known as photogrammetry (Aber et al., 2010).  
The objective of this study was to develop 2-D photogrammetric and 3-D topometric imaging methods for HTP of spike characteristics in perennial ryegrass with special attention to traits that might be associated with seed retention.
MATERIALS AND METHODS 
Overview
Field studies were conducted near Corvallis, OR in two years (2017-2018 and 2018-2019) to identify genetic variation for seed retention and to ascertain whether there was variation in phenotypic traits that contribute to seed retention in perennial ryegrass.  The trial examined variation in these traits in 21 diverse global accessions and genotypic lines within accessions.  Information on experimental methods for plant materials are published elsewhere (Tubbs and Chastain, 2022).
 This work focused on development of morphological trait measurement methodology in perennial ryegrass spikes and employed three different methods of phenotypic trait capture and measurement: i. direct data capture by standardized hand measurement, ii. 2-D image capture and photogrammetry, and iii. 3-D image capture with the Artec Space Spider 3-D scanner (Artec 3-D, L-1466, Luxembourg) (Figure 1).  Each proximal image capture method required the development of procedures in order to obtain the desired information.  Computations of trait measurement accuracy and data analysis for comparing methods was done by using R studio (Version 1.3.1093) unless otherwise specified.  
2-D Image Capture
This method begins with capture of a 2-D image of the spike, followed by processing of the image to extract the desired trait data (Figure 2).  Spike images were captured by using a Nikon D5000 digital SLR camera.  This camera uses the visible portion of the EM spectrum with a resolution of 4288 x 2848 pixels.  Images were acquired by use of a RGB CMOS (Complementary Metal-Oxide Semiconductor) sensor with a pixel size of 5.5 µm.  Each spike was cut 2.5 cm below the lowest spikelet and was then gently laid onto an aluminum plate inside a plastic container.  The aluminum plate was light, rigid and covered the bottom of the container.  A ruler was placed besides the spike and an image was taken from 0.5 to 1 m.  This step required less than a minute to accomplish but at times glare from sunlight reflecting off the aluminum had to be shaded.  Images were made with a focal length of 35 mm to capture details of the spike.
The open source image package Fiji was used for post-processing of images.  Fiji is a distribution of ImageJ software that has been bundled with plugins designed for scientific image analysis (Schindelin et al., 2012; Rueden et al., 2017).  Post processing of an image took about five minutes to obtain spike length, spikelet number, internode length, and the 2-D curvature of the spike. 
Fiji is a software package in extensive use in scientific (Graff et al., 2012; Schneider et al., 2012) and medical fields (Aragón-Sánchez et al., 2017).  To test the 2-D measurement method using images and Fiji software, ten different lengths of printed line were randomly generated ranging from 13 cm to 22 cm, and a control line set for 25 cm were photographed multiple times from different camera angles.  Observationally, it appears that the Fiji measurements were on average just slightly (3-4 mm) shorter than the computer-generated length and the length measured by hand.  This slight, but consistent trend is the result of images not being captured directly perpendicular to the subject causing slight distortion of the photograph.
2-D Spike Length, Spikelet Number and Internode Length
The length of the spike and internode length within the spike can be measured at the same time by the 2-D measurement method.  The first step, after installing Fiji, was to open the image of interest and orient as desired using the [Transformation] options under the [Image] tab.  A new macro that measured the distances between line segments was downloaded (asdfasdfs, 2014) (supplemental information) then installed by selecting [Plugins]/[Macros]/[Install] and navigating to where the program was downloaded.  This macro generates a table with all the line segment measurements when the number “1” is pressed on the keyboard.
Setting the scale within the image was an important step and was done by selecting the [Straight Line] tool option on the tool bar.  With the straight-line tool, a point was marked at the beginning of the measurement marks on the ruler within the photo.  Then the second point was placed at the 20 cm mark on the ruler.  The [Set Scale] option was selected under the <Analyze> menu dropdown.  The known distance (20 cm) was entered on the Set Scale popup box - this action associates the known distance with the distance in pixels on the photograph.
The segmented line tool was selected by right clicking on the straight-line tool and choosing the [Segmented Line].  Spike length, internode length and spikelet number were measured with this tool.  Points were placed on each spikelet insertion point on the rachis, beginning with the lowest spikelet, with the left mouse button.  The last point was placed on the tip of the last spikelet by using the right mouse button to let the software know that the measurement was complete.  When the number 1 button was pressed, a table with the measurements appeared.  Each cell in the table contained the internode distance between spikelets along the rachis while the sum of all cells was the spike length, and the number of cells minus one was the number of spikelets.  
2-D Curvature
One physical manifestation of spike architecture was the curvature; spikes are rarely straight – most have an inherent curvature and this trait was investigated for its potential biological significance.  Yates (1974) defined curvature as a measure of the rate of change of the angle of inclination of the tangent with respect to the arc length.  Curvature is very difficult to measure without using photogrammetry.  Fiji was used to calculate the curvature of spikes.  Two different mathematical methods were used to calculate curvature, they served as a verification check on the curvature apparent in an image.  Both processes used three different points that were manually selected on the image.  The first method used the intersection point between two perpendicular bisectors of the two chords between points that lie upon a circle.  The second method found linear equations for the circle by using determinates of the equation. 
2-D Curvature-Intersection of Perpendicular Bisectors
Proposition 1 of Book 3 of Euclid’s Elements discusses how to find the center of a circle by bisecting a chord between two points (Fitzpatrick, 2007).  With this understanding the curvature of a spike can be found using Fiji.  A 2-D image of a spike is loaded and the scale is set as previously discussed.  The first chord is formed between the first point, usually the first intersection of the spikelet with the rachis and the center of the spike.   The second chord is between the center of the spike and the tip of the spike.  The perpendicular bisectors are found for the two chords that join the three points.  The intersection of the two perpendicular bisectors cross is the center point of a circle that would circumscribe all three points.  The radius of the circle is found using the distance formula between the newly found center point and one of the points known on the circle.
For a chord AB, with and  the equation of the perpendicular bisector is:

The midpoint is:

The slope of the segment defined by A and B (the chord) is:

The slope of the line perpendicular to the segment AB is:

The equation of the line required is:


or

This is the equation for the perpendicular bisector between points A and B.  The process would be repeated for points B and C to find the second perpendicular bisector.  With two perpendicular bisector equations the point of intersection can be found, which is also the center point of the circle.
Simplifying the two equations to  and 
The center of the circle is found at:

Lastly the distance formula is used to determine the radius; the distance between the center point and a point on the circle :

[bookmark: _GoBack]2-D Curvature - Using Determinates to Find the Center of a Circle using 3 points.
The second method, as outlined on the website http://ambrsoft.com (AmBrSoft, 2020), is accomplished by using three points  and the equation circle:

A determinant can be created:

The coefficients A, B, C and D can be found by solving the following determinants:




The values of A, B, C and D will be after solving the determinants:






Center point  and the radius of a circle passing through the 3 points  ,  and  are:




Indexing and Verifying
Curvature (K) is defined as the reciprocal of radius (r) of curvature (Kline, 1998).  Curvature can be expressed as:

Curvature was used as an index by which the perennial ryegrass spikes were evaluated.  The Python code created by Martini (2016) for measuring the angle of curvature of a claw was adapted to measuring spike curvature (supplemental information).  This code was adjusted to use the above two mathematical processes for finding the radius of a 2-D circle that fit three given points (Figure 3).  The equations were tested and verified using the website ambrsoft.com (AmBrSoft, 2020).
The code was tested by creating 10 circles of random diameters using the online mathematical platform www.math 10.com (Petrov, 2021).  Each circle was converted into an image and uploaded into ImageJ.  The Python code for curvature was used to evaluate the curvature and midpoint of each circle.  Accuracy of this method was logarithmically related to the angle between the two outer points, the smaller the angle (i.e., the straighter the object) the less accurate the curvature measurement.  To alleviate this problem any angle that was less than 20° was considered negligible curvature.  
3-D Image Capture
Capturing 3-D images can be time consuming and required some practice using the Space Spider but experience decreased the capture time substantially.  The post-processing procedure was also more time consuming than 2-D data processing because of the amount of data that was captured (Figure 4).  A Surface Book with an Intel core i7 was used for all data capture and processing.  Since this device had not been previously used for the purpose of HTP, several different approaches were tried to find the best way to capture phenotypic characteristics of spikes in 3-D.  Efforts to capture spikes in the natural upright position failed as a result of spike movement in the wind, poor background differentiation, and interference with other spikes.  The best method for capturing spike data was to first mark the spike of interest.  Brightly colored tape was fixed at the base of the inflorescence so that the same spike could be scanned over time.  A contrasting background is important for the camera to track the spike, one that has a lot of color and texture.  Brightly colored purple and blue resistance bands (often used for physical therapy) were laid out on the ground as they provided high contrast to the spike and ground.
The spike was gently laid down onto the background band and carefully held in place by a weighted object.  This process worked well for perennial ryegrass because the spike is bilateral in form, so the underside does not need to be scanned.  A pushcart was used to hold equipment, but had an additional purpose in shading the subject spike from the sun and to block wind that could move the spike during scanning.  Direct sunlight had the greatest impact on the scanning process.  The greatest difficulty in scanning spikes was encountered during the hours before and after the solar zenith.  On the other hand, the Space Spider captured spike images exceptionally well in the morning, evening, and all through the night because of the on-board structured light source.  The scanning process was conducted according to recommendations outlined on the Artec3-D website (Kivolya, 2019).  The scanning process for a single spike was completed in about 2 minutes depending on environmental factors mentioned previously.  Under the right conditions and with experience, the scan time for a single spike was reduced to about 30 seconds.  Upon completion of a successful scan, the file was unloaded from the Artec Studio software, which greatly reduced the memory requirement.
Artec Studio Software
The Artec Studio software package has advanced 3-D scanning and data processing capabilities.  This software analyzes multiple scans that were collected, orients them in space, and then meshes them together forming a complete 3-D model.  To ensure consistency, the autopilot function was used to process scanned data.  The autopilot option is “an advanced smart mode that guides the user through post-processing in a few steps, automatically selecting the most effective settings and producing a 3-D model” (Artec 3-D, 2020).  Once a complete mesh has been compiled, the 3-D model can be exported for further analysis.  
3-D Spike Length; Spikelet Number, Length, and Angle; Internode Length
The principal traits of interest in this trial were spike length, spikelet number, spikelet length, spikelet angle, and internode length.  Precise collection of this data using Artec Studio’s [Measures] option was quickly and easily obtained in post-processing.  The [Distance] option was selected from the measurement options available in the software for this purpose.  This option permits the user to select a series of points on the model and the software will calculate the distance between each point and provide the x,y,z coordinates for each point.  
For spike length, spikelet number and internode length, only one set of points was required. Each point was positioned at the center of the mesh’s rachis at the insertion point of each spikelet along the rachis, beginning at the first spikelet insertion point and ending at the tip of the spike.  The total distance (length of the spike) was automatically calculated in mm, the spikelet number was determined to be 1-n (where n is the number of points positioned at each spikelet intersection). The 1-n equation was to account for the last point at the spike tip that was required for the total length.  The internode distances (measurement between each insertion point of the spikelet) were found by exporting data to a spreadsheet using the [Export] button.  Exported data contained x,y,z coordinates for each point as well as the distance from previous point.  
Spikelet length and spikelet angle were easily obtained, but had to be calculated separately using two additional coordinate sets.  The first step was to create two additional linear distance sets of points using the Artec Studio [Measures] option.  The first set was created by placing a point on the tip of each spikelet on only one side of the spike beginning with the first spikelet.  The second linear distance set of points was found by positioning points on each tip of the spikelets on the opposite side of the first spikelet.  Both linear sets were exported to a spreadsheet.
Data in the spreadsheet was used to calculate additional trait data.  Because perennial ryegrass spikelets grow in an alternating pattern along the length of the rachis, the two additional data sets measuring the tips of the spikelets the two respective sides had to be combined in an alternating fashion beginning with the set that contained the first spikelet.  This process was easily done in the spreadsheet by pasting the data together on the same spreadsheet simply numbering the first set with odd number and the second set with even numbers and then sorting the numbering column from least to greatest.
The point coordinates from the initial core data set, containing the internode points along the rachis were used in conjunction with the newly combined point coordinates, containing the alternating spikelet tip coordinates.  The length of the spikelet is simply the distance from the tip of the spikelet to the point where it intersects with the rachis.  The 3-D distance equation used was:

To find the spikelet angle, coordinates from three points were used to create two vectors (Strack, 2020), one vector representing the spikelet and one representing the next internode length (Figure 5).  The first step was to set the intersecting point between the spike and the internode as the vector origin.  This was done by subtracting the coordinates of the intersection node from the associated spikelet tip coordinates and from the next intersecting node coordinates.  The formulas and calculations come from and were verified using the website www.omnicalculator.com (Pamula, 2021).
For vector  (spikelet vector):  A= (coordinates of tip of spikelet),

  B =  (coordinates of spikelet’s rachis intersection)



For vector  (internode vector): B =  (coordinates of spikelet’s rachis intersection)

    C =  (next spikelet rachis intersection)


The spikelet angle  is the dot product of the two vectors:





3-D Curvature
The 3-D curvature of the spike was found using R studio (supplemental information).  The equations and code were found on https://math.stackexchange.com (mehmetkilic, 2020), and then incorporated into the graphing/analytical software to calculate the spike curvature (Figure 6).  The three points in space were designated to be  and the center of the circle passing through them is . In space, the geometric locus of the points equidistant to these three points forms a line and this line intersects plane at .
Then, let  be a point whose distance from the three points is and the Cartesian coordinates of  should satisfy the following three equations.
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Subtracting Eq. (1) from Eq. (2) and Eq. (3) and after simplifications,
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Where:
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Eq. (4) and Eq. (5) are linear in terms of  and . Solving them yields,

	(14)
	


	(15)
	



Where
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Putting Eq. (14) and (15) into Eq. (1), it simplifies to the following equation form:
	(21)
	



Where
	(22)
	


	(23)
	



Eq. (21) is quadratic in terms of  and has two roots. So, there are two points in space whose distance is  from the points . Let these points be  and . The key observation here is that  and  are symmetric with respect to  plane. Then, point  is midpoint of the line connecting  and .  can be calculated with the following formula:                                                                                                                                          
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Like point, point is equidistant to the three points. So  also satisfies Eq.(14) and (15).  The last coordinates of the center point are,
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A script in R Studio (Version 1.3.1093) was written with these equations and the 3-D coordinates from Artec Studio of each scanned spike to obtain the 3-D curvatures.
Skeletonization of the 3-D Spike
The 3-D skeletonization of the spike is a process of creating a compact representation of an object through extracting the fundamental centroidal centerline while preserving the geometric and topologic properties.  Two different methods were used to extract 3-D skeletal data from models created with Artec Studio for trait characterization.  The first method used parallel medial axis thinning to skeletonize the Artec Studio created .stl file.  The second method used ImageJ plugins and the open source software 3-DSlicer to extract skeletal data. 
Skeletonization with Matlab
Matlab code was created to evaluate the skeletal structure of the perennial ryegrass spike.  The code was derived from three other codes found on the MathWorks file exchange website (MathWorks, 2021).  The three Matlab codes used were: 3-D Average Outward Flux Skeletons (Hong et al., 2017; Rezanejad, 2020; Siddiqi et al., 2002), Mesh voxelisation (Aitkenhead, 2021), and Skeletion3-D (Kollmannsberger et al., 2017).  This code finds the 3-D skeleton of a 3-D model.
Skeletonization with Fiji and 3-DSlicer
After a spike was scanned with the Artec Space Spider, the Artec Studio software combined all the scans into a single mesh file.  The mesh had to be edited so that only the desired object (spike) remained.  The 3-D model object was rotated into the proper orientation, with the direction to be skeletonized spike running in the z-axis (usually the longest length of the object).  Once the object is in the correct position and orientation, it was exported from Artec Studio as a 3-D mesh (.obj or .stl file).  
The next step was to import the object into the open source 3-DSlicer software.  This can be done by pasting the Python code into the python interactor window of 3-DSlicer (Lasso, 2019) (supplemental information).  This code sliced the object into numerous 2-D .tiff images in a sequence known as a “stack”.  The new stack was then opened in Fiji using the File->Import->Image Sequence option.  The first image in the stack was selected and after Sequence Options window opens, the Convert to 8-bit greyscale was checked followed by selecting the OK button. Using the Plugins->Skeleton->Skeletonize (2D/3-D) option, the stack of slices was converted into a stack of points by iteratively eroding the object’s surface until only the skeleton remained.
The new stack of skeletonized points was then open in the Plugins->3-D Viewer.  When the “Add…” pop-up window opens, the “Display as” drop down box was changed to “Surface”.  To make it easier to see the Color drop down was changed to “White”.  The “Threshold” number was changed to 1 to maximize the points that were converted to a 3-D image.  In the Fiji 3-D Viewer window, the skeletonized object was saved using File->Export Surfaces->STL (binary).  This exported a .stl file that can be viewed in any 3-D imaging software or even printed on a 3-D printer.  
Direct Data Capture
Methods chosen for direct data capture were from the current standard in-field phenotyping procedures as outlined by the United States Department of Agriculture’s objective description form designed by the Plant Variety Protection Office (Plant Variety Protection Office, 2015).  More details of the application of these methods in the measurement of spike characteristics by direct data capture are published elsewhere (Tubbs and Chastain, 2022).


RESULTS
Measurement Accuracy-Spikelet Numbers
There is inherent accuracy variation for each measurement method.  This section presents the overall accuracy differences between 2-D and 3-D imaging for the trait.  Spikelet number was counted first by the direct data capture method, and later counted using 2-D imaging and 3-D imaging software.  There was no significant difference among the two imaging methods and hand counting.  The 2-D imaging method had an average of 5.6% discrepancy and the 3-D imaging method had an average of 5.0% discrepancy from the hand counting method between the two years (see Figure 7a).  
Measurement Accuracy-Length
The ability to accurately determine distances in a remotely captured image is essential for accurate trait measurements.  To verify the efficacy of the two methods, random lines were generated and measured using different methods.  Because this was a field test, it was important to determine how well an image could be measured without a fixed frame.  Two variations of 2-D images were captured with the Nikon D5000; one directly nadir to the spike and one that was taken as a slight angle.  The slight angle was important for testing the accuracy of measurement when the perspective varied.  The 3-D imaging did not require testing different angles of imaging because the entire capture process required movement of the Artec Space Spider to capture the 3-D image.  
There was no significant difference in the deviation percentage of measurements made with 2-D images either at an angle or nadir to the spike (Table 1).  There was a difference (P ≤ 0.01) between deviation percentages of the 2-D image measurements and length measurements done either by hand or with 3-D image analysis, but there was no difference between measurements done by hand or by 3-D.  The 3-D method was the most accurate measurement method with a deviation percentage of 0.17%.  The deviation percentage of measurements made by hand was slightly greater at 0.25%.  The 2-D image measurement had a deviation percentage of 1.91% for images taken at a slight angle and 2.10% for images taken directly over the spike (Figure 7b).
Measurement Accuracy-Angles
Fiji can measure angles directly but only in 2-D and Artec Studio measures coordinate points which can be then converted into angles using additional software (i.e., Excel, or R studio).  The limitation of Fiji to two dimensions greatly reduced its usefulness in measuring spikelets.  The accuracy of both methods was tested by generating random known 2-D angles and then measuring them in Fiji.  The angles were overlaid onto a 3-D plane and uploaded into Artec Studio to verify its angle measurement accuracy in conjunction with Excel for generating angles. Both methods proved to be highly accurate at measuring angles, with no significant difference between them.  Artec Studio had a deviation error of 0.23% while Fiji had an error of 0.28% (Figure 7c)
Measurement Accuracy-Curvature
The phenotypic trait measured through remote sensing was spike curvature.  A comparison was made by generating random circles of a known diameter with an internet-based program (Lee, 2012).  The circle images were loaded into Fiji and the curvature was obtained by using the curves Python code.  As with the angle images the circles were loaded onto a 3-D plane in Artec Studio.  To ensure consistency between programs only 90° and 45° angles were measured, and the deviation percentage was calculated.  There was no significant difference between the two angles using Fiji and there was also no difference between the angles using Artec Studio and the curvature R-studio program.  However, a difference (P ≤ 1.0 x 10-7) between 2-D and 3-D curvature measurements was evident. The 2-D curvature measurement using Fiji had a deviation error 0.47% compared to the 3-D curvature measurement deviation error using Artec Studio of 5.46% (Figure 7d)
Skeletonization
The skeletonization of the spike mesh provides the core data representing the 3-D mesh.  Two different methods were used to calculate the 3-D skeleton of the spike.  Both the Matlab skeletonization and the Fiji/3-DSlicer methods generated similar appearing spike skeletons but the Matlab skeleton is only a set of coordinate points lacking actual structure and volume (Figure 8).  The skeletons were intended to be used to determine spikelet angle, but further investigation revealed that the angles obtained from the skeleton were not representative of actual spikelet angles of insertion to the rachis.
Discussion
HTP Spike Trait Assessment
Proximal sensing is a valuable method of non-destructively capturing detailed phenotypic perennial ryegrass trait data.  The methods developed provide detailed instruction for utilizing a Nikon D5000 camera and 2-D image processing software Fiji and the 3-D Artec Space Spider camera and Artec Studio.  Each method had inherent advantages and disadvantages so not all were applicable in HTP of perennial ryegrass spike traits.  The resolution of the Artec Space Spider was not sufficient to consistently capture the fine details to count florets under field conditions. 
The skeletonization of the spike as part of the image processing and analysis process was found to not be necessary to obtain the desired data such as the angle of spikelet insertion on the rachis and overall spike architecture.  Other methods developed here delivered superior results in less time.  The skeletonization process is widely used for description of shapes, 3-D model identification, and many other applications (Jin and Kim, 2017).  Bucksch (2014) used this process to analyze many morphological characteristics of plants including leaves, branches and roots.  Chaudhury and Godin (2020) examined the skeletonization processes as a method to assist in automated phenotyping traits of plants.  Research using 2-D perennial ryegrass images has employed skeletonization to evaluate shattering propensity of spikes (Barreto Ortiz, 2019; Barreto Ortiz et al., 2020).  
Spikelets per Spike
There was no difference among methods for the numbers of spikelets per spike whether this was accomplished by hand-counting, 2-D imaging, or by 3-D imaging.  The over/under spikelet count deviation using proximal sensing can be accounted for in the 2-D imaging because there were spikelets that could not be seen in the image due to their position under the spike.  Poor image quality in some cases could also have been a factor.  The 3-D imaging also had some resolution problems.  An over count of spikelets could happen under windy conditions during scanning, the spike may have shifted position slightly causing a duplication of some spike traits.  Usually, the software can correct for this but not always.  
Length Assessment
The ability of the Artec Space Spider to precisely measure lengths is one of the key features that made it stand out as a precision tool for trait assessment.  While some fine features were unable to be captured such as the individual floret with the present resolution of the device, the overall capability of this camera and software system has great potential for trait identification.  Shadrin et al. (2018) discussed using the Artec Space Spider in research for measuring and predicting plant growth.  Similar 3-D technology is already being applied to autonomous weed management and harvesting systems (Gai et al., 2015; Li, 2014).  One drawback to this method is that post-processing does take about half an hour to render all scanned images into a consolidated mesh.  
Using Fiji with 2-D images was less precise than hand measurement and 3-D measurements but for many field applications the ~2% deviation may not be considered consequential.  The collection and post-processing required much less time investment compared to the 3-D imaging, saving 20-30 minutes per image.  Advances in artificial intelligence and image processing could make this process even faster.  Fiji has been used in many areas of research.  This is not the first time that this software has been used to measure plant characters as it has been used to quantify leaf characteristics of Arabiopsis thaliana (Maloof et al., 2013) as well as leaves of fruit trees (Cosmulescu et al., 2020).  Heineck et al. (2019) recently used this software to quantify rust pustules on perennial ryegrass and was used by Jayasinghe et al. (2019) to assess perennial ryegrass stand persistence.  
Angle of Spikelet Insertion on Rachis
Both 2-D and 3-D methods for determining angles within an image/mesh were both accurate, having less than 0.33 percent deviation from the known angle.  While angle measurement is possible with the Fiji software, the process was lengthy because the angle of each spikelet must be measured individually and it is imprecise since not all spikelets were accurately measured as a result of the 2-D nature of the image.  The spikelet angles measured using coordinates captured with the Artec Space Spider required additional software to calculate individual spikelet angles.  One important advantage was that all the spikelet angles of a spike could be captured at once using only three measurements with Artec Studio software.  While there was no significant difference between the two methods in accuracy at measuring angles, only the 3-D capability of the Artec Space Spider could practically be used for measuring the angles.  The process of converting 3-D coordinates into angles does take several steps.  The manual processing time for calculating the angles on a spike was about 5 minutes.
Spike Curvature
The curvature of the spike is one morphological trait that has not been possible to practically measure before development of these methods because this aspect of the plant’s architecture varies in three dimensions.  Many plant structures have a natural curvature like the spike so there might be applicability of this methodology to increase our ability to capture and measure these structural features.  No previous research has been conducted to measure the curvature of spikes in perennial ryegrass.  There appears to be roughly a 5.5% discrepancy in the curvature calculations between methods.  The measurement discrepancy found between 2-D and 3-D curvatures results from the overall systems of measurement.  The Python code used by Fiji to measure curves drew a red line bisecting the curve so that precise measurements could be made every time.  The same level of precision was not available inside the Artec Studio software. There could also have been some unknown variability in converting the image from 2-D to 3-D.  Another factor could have been the fact that Fiji allowed the scale to be directly established based off the image whereas the 3-D studio software was not designed for this type of evaluation, so the uploaded circle images had to be scaled up to a known measurement length that matched what was found on the image.  The capability to assess curvature in three dimensions despite this higher measurement deviation gives the Artec Space Spider some distinct advantages.  
CONCLUSION
[bookmark: _Hlk75196757]This work was aimed at determining whether proximal sensing methods improve data capture and measurement of spike traits in perennial ryegrass.  The methods explored and developed here demonstrated the capability for use as tools for HTP.  Data capture and measurement of additional plant traits is possible using adaptations of these methods.  This paper and the codes (supporting information) developed from this work may provide the foundation for additional research in this area.  More work will be needed to automate the process for more rapid data collection and processing.  The skeletonization process may also have some application for future research requiring 3-D structure characterization but was not needed for the intended purpose of this work.  The methodology permits quick data acquisition and processing while simultaneously reducing expensive, time consuming, and tedious phenotypic trait measurements in the field.
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Figures and Tables
Figure 1. Flow chart of HTP data collection for perennial ryegrass spike traits using 2-D and 3-D image capture as well as direct observations and conventional hand capture.  Hardware and software needed for data collection is listed below.

Figure 2. Data collection and image processing flow path for 2-D HTP in perennial ryegrass spikes. 

Figure 3. Measurement method for the curvature of the perennial ryegrass spike using the curves Python code in the Fiji software is depicted in the screen capture below.  Three points are supplied to the code which then places a red line in the center of the curve and the points are allowed to be repositioned as needed.  When the points are finalized, the code will output the angle between the two end points, the radius of the circle that would inscribe the three points and the curvature.
 
Figure 4. Data collection and image processing flow path for 3-D HTP in perennial ryegrass spikes.  

Figure 5. Perennial ryegrass spike image after 3-D mesh created by using the Artec Space Spider (top image.  Images of spikelets showing how the angles of insertion on the rachis (central axis) were determined by the Artec Studio software’s measurement tool (bottom images).  The coordinate points on the image were used to calculate spikelet angles. 

Figure 6. Curvature of the spike in 3-D.  Data generated in R studio from the coordinate points of the scanned spike using the Artec Space Spider and Artec Studio.
 
Figure 7. Comparison of 2-D and 3-D imaging system accuracy: a) spikelet over/under count percentage by using proximal imaging tools over two years. b) length deviation percentage of various measurement methods of randomly generated lines c) angle deviation percentage between 2-D and 3-D imaging methods for randomly generated angles d) curvatures deviation percentage for 2-D and 3-D imaging methods using 45° and 90° angles on randomly generated circles. 

Figure 8. Comparison of Matlab and Fiji skeletonized perennial ryegrass spikes.  The fly out depicts the structural differences between the two methods.  Matlab is a series of coordinate points compared to a 3-D structured mesh derived from Fiji. 












	[bookmark: _Ref73427608][bookmark: _Ref73427603]Table 1. Significance of deviation percentage using post hoc pairwise comparisons using Tukey in R studio.


	Pairwise Comparisons 
	Deviation % from known Standard

	Camera-nadir:Camera-angled
	ns †

	Hand measured:Camera-angled
	**

	3-D scan:Camera-angled
	**

	Hand measured:Camera-nadir
	**

	3-D scan:Camera-nadir
	**

	3-D scan:Hand measured
	ns †

	
	**P ≤ 0.01
	
	†Not significant
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